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Abstract 
 

This manual shall serve as a guide for the user in carrying out all the operations in the COMES 

application. The application must be installed in the User’s computer and the manual should be 

studied carefully. Note that every step was carefully explained for each category of user. 
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USER OPERATIONAL MANUAL 
 

Workflow 

 

This section of the user document provides a comprehensive details of the step by step 

operation of the COMES application. The document is further divided into different 

sections under the following headings: 

 

i. Starting the Application 
 

ii. Setup Parameters 
 

iii. User Login 
 

iv. File menu operations 
 

v. Examiner Data menu operations 
 

vi. Malpractice Operations 
 

vii. Report operations 
 

viii. Tools and Setup operations 
 
 
 

 

i. Starting the Application 

 

To start the COMES application, 

 

i. Locate the icon on your desktop as shown below:  
 
 
 
 
 
 
 
 
 
 
 
 
 

 

ii. Double click the icon or right click the icon and click Open command. This opens    

    the operation page. (see figure 1a) 
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1. SETUP PARAMETERS 

 

    The user is expected to setup all the required parameters before the major   

     operations are carried out. The Items that needs to be setup include: 

 

i. Head of Venue profile 
 

ii. Secretary of Venue profile 
 

iii. Marking Venue for the current Exam 
 

iv. Enabling of Marking Venue data for the Current Exam 

 

     Before the setup stage begins, the introductory screen appears which verifies     

     that necessary data are preloaded: 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
                                             Fig. 1b 
 
 
     Select the desired user to setup the profile and click Next>> 
 
 
 
 
 



 
 
 

4 
 

A window is displayed as shown below: 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
From the above screen: 

 

i. Click Main Marking File button. Locate the master file and select the file. 

This will process the file and show you the exam diet the file contains. 
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ii. Select the Marking Venue, click the Confirm file import process. 

 

iii. Click the Setup Data button 
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iv. When the import finishes, from the confirmation screen below, click the OK 

button 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 

v. When the above screen closes, the screen below will display: 
 
  
 
 
 
 
 
 
 
 
 
 
 
** 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                                                                                Figure 1c 
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Note that you are expected to follow the setup process step by step (from 1 to 4) 

 

1.1 Head of Venue Profile Setup 

 

i. Click the Link Click to Add Head of Venue (as shown in Fig 1c) 
ii. The Screen below opens alongside the screen in figure 1c: 

 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
                                                     Figure 1d 

 

iii. Enter all the required details. All entries are compulsory. 

Note that the current Role will always be selected. 
 

iv. Click the Submit button 
 

v. You can click the Close button at any time to close the screen 
 
 

The windows below will then be displayed:                                                    
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Figure 1e 
 
1.2 Secretary of Venue Profile Setup 

 

i. Click the link Click to Add Secretary Details 
 

ii. A Screen similar to figure 1e opens alongside figure 1e. 
 

iii. Enter all the required details. All entries are compulsory. 

Note that the current Role will always be selected. 
 

iv. Click the Submit button 
 

v. You can click the Close button at any time to close the screen 
 

The following fields will be selected automatically for you; Computer 

User, Exam Type, Marking Year, Head of Venue. 

 

2. USER LOGIN 

 

The User login screen provides access to all or some of the components of the 

system depending on the user’s role. All Administrative access have parallel 

privileges while other users have limited privileges. 
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After the initial setup is completed, the screen below will be displayed for the user to 

login. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The User would be expected to: 

 

i. Enter the User name used in the User Setup 
 

ii. Enter the Password as supplied in the User Setup. 
 

The box ‘Remember my password will always be checked. You can 

uncheck it if you don’t want the system to remember your password. 

iii. Click Login button 
 

iv. Successful login would grant you access to the system otherwise, you 

would see the message below: 
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Successful login to the application will open the main screen containing menus for 

carrying out the Marking Venue operations. 

 

3. MAIN WINDOW MENUS 
 

 

 

The main screen that appears after successful login contains menu items for 

carrying out related operations in the Marking venue. The hierarchies of the menus 

are as follows: 

 

(1) File 
     Capture Quality Control Sample 

     Change Password 

     Register User/Staff       

     Log Off 

Exit  
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 

                   
 
                                                          Figure 3a 
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(2) Examiner Data 

      Examiner Lookup     

      Examiner Teams: 

-Dynamic List of all Subjects within the marking venue. This differs for     

 each marking venue 

     Upload Document 

   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
                        

                                          Figure 3b  

 
(3)  Finance 
      Setting 
               -Banks 
               -Bank Branches 
               -Paper Fees 
               -Rank Fees 
               -Marking Status 
               -VAT Settings 
      Preload payment details 
      Examiner Payments: 

- grouped into all Subjects within the marking venue. This differs for     

 each marking venue 

      Compute Examiners Payment Data 
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(4) PED Operations 
 
 
 
 
 
 
 
 
 
 
 
 
     Malpractice Data Entry 
     Generate Broadsheet 
     Open Broadsheet Report 
     Centres for Scrutiny 
     Update Malpractice Source 
     Upload Malpractice Data 
 
(5) SEAPDC Manager 
 
 

 
 
 
 
 
 
 
 
 

Settings 

-Offence Settings 

Offences Capture 
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(6) Tools 

 

 

 

 

 

 

 

 

 

 

Export Final List Data 

Export Malpractice Data 

Reset Marking Venue 

Import Final List 

Import Centres 

Upload to Online Server 

 
(7) Reports 
 

 
 
 
 
 
 
 
 
 
 
 
 

   Provisional List 

      Dynamic List of all Subjects within the Marking 

     Venue Final List 

Dynamic List of all Subjects within the Marking 

    Venue List of Examiners 

    Audit Trail 

    Marking Venue Staff list  

    Quality Control Sample 

    Finance 

    Centres for Scrutiny 

    SEAPDC Reports 
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Most of the menu items operations can be performed from the toolbar as shown 

below: 

 

FILE MENU OPERATIONS 

 

3.1.1 Capture Quality Control Sample 
 
        i. Click on File 
        ii. Click Capture Quality Control Sample. The screen below opens 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
     
 
 
 
  iii. Select the Paper Name from the drop down arrow in front of Paper Name.       
           The screen below opens  
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iv. Enter in the scores for each candidate and press the Enter key to move to the                                         
     next candidate. 
v. The scores are automatically saved once entered.  
vi. Once all the scores have been entered, click on the close button to end and then  
     go back to File – Quality Control Sample to select another subject.  
 

3.1.2 Change Password 
 

         Only current user who is logged on can use this option to change his/her  
         password. 
 

i. Click File 
ii. Click Change Password. The Screen below opens 
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iii. The screen will contain your User ID and Phone number used in 

the registration process. Enter your old password. 
 

iv. Enter the new password and confirm the new password 
 

v. Click Change Password button 
 

vi. You can click the Close button at any time 
 
 
 

3.1.3 Register User/Staff 
 

i. Click File 
 
           ii. Click Register User/Staff 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
         iii. Select the User Role to be setup. 

         iv. Enter all the required details. All entries are compulsory. 

Note that the current Role will always be selected. 
 
        v. Click the Submit button 
 
        vi. You can click the Close button at any time to close the screen 
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3.1.4 Log Off: This process logs the user off and open the login screen 
 

i. Click File 
 
           ii. Click Log Off. This opens the screen below:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                          
            iii. Enter your login details again 
 
            iv. Click Login button 
 
             v. You can click the Close button at any time to exit the application 
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3.2 EXAMINER DATA MENU OPERATIONS 
 
3.2.1 Examiner Lookup: This facility helps the user to search for existing 

examiners whose record need to be verified at marking venue using 

different criteria. To use the tool: 
 

i. Select the Examiner Lookup option from the Examiner Data menu 
 

ii. From the screen that opens, select the search option you would prefer 
 

iii. Click the Search button. For more information, see the screen below. 
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3.2.2 Examiner Teams: All teams available in the Marking Venue are accessible   
         using this menu option. 
 

i. Click Examiner Data 
ii. Point to Examiner Teams > 
iii. Select the Subject for the Team (Example: 203222 – 

ECONOMICS 2). This will open the screen below: 
 

                                                    

                                                    Figure 3b 

                             
The above screen can be used to perform the following operations: 

 (a) Swapping of Examiners 

 (b) Moving Examiner 

 (c) Update/amendment of examiner details 

 (d) Create a vacancy for a team (This is done by the Head of Venue) 

 (e) Biometrics and Uploading of Documents 
 
 
 
 

                                                                                                                                                   



 
 
 

20 
 

            
3.2.2.1 Swap Examiners: 
 

This process is used for swapping two examiners between teams based on 

vacancy and seniority. Ensure any changes made previously has been saved 

before proceeding. To proceed with this option: 
 
           i. Check Swap Examiners check box 
 
           ii. Click any cell in the row of the first examiner you want to swap 
 
           iii. Click any cell in the row of the second examiner to be swapped with 
 

Always check the black information box to review your selection. The screen       

       below show a preview of selection made: 

 
                      
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

               
        iv.     Click the Swap Examiners button 
 
 

        v. The message below will be displayed. To continue click the Yes button, to  

            decline, click the No button, as shown below: 
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Once you click on the Yes button, the examiners will immediately be      
        swapped between the selected teams without changing the Examiner Codes   

       for either of the team. 

 

 

3.2.2.2 Move Examiner: 
 

This process is used to move examiner from current team to another team. To 

move an examiner from Team B to Team A, select the Examiner in Team B 

before the examiner in Team A, this will move Team B examiner to the position 

of Team A examiner and create a vacancy at the position of Team B examiner. 

Please ensure that there is vacancy before an examiner is moved to a new team. 

Also ensure any changes made previously has been saved before proceeding. To 

proceed with this option: 
 

i. Check Move Examiner check box 
 

ii. Click the team cell in the row of the examiner you want to move 
 

iii. Click the team cell in the row of the destination you want to move 

the examiner to. 
 

Always examine the changes in the black information box to review your      

        selection. The screen below show a preview of selection made: 
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iv. Click Move Examiner button. 
 

v. The message below will be displayed. To continue, click the 

Yes button and to decline, click the No button, as shown below: 

 
 
 
 
 
 
 
 
 
 
 
 

                          
 
 
                      vi. You will then be asked to confirm that the examiner to be replaced is  
                            indeed absent. The message below will be displayed. 
 
 

                                     
 
 
 
 
 
 
 
 
                           



 
 
 

23 
 

-Once the Yes button is clicked, the examiner will immediately be moved to the     

        selected team without changing the Examiner Code for the previous team. 

The Provisional List for a subject can be restored by clicking on the link Restore 

Provisional List. 

You can search for a particular examiner within a team by entering in the 

Examiner number or Telephone number of the examiner in the box ‘Filter List by 

Examiner Code or Telephone.  

 
 

3.2.2.3 Biometrics and Documents 

            This option is used for the following: 

 

1. Biometrics: 

Used for Photo capture, Fingerprints Capture, Signature Capture and  

                 Fingerprints Verification. To carry this out: 

i. Click on the Biometrics and Documents link as seen in Fig 3b. The  

     following screen is displayed: 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
              ii.    Select the fingerprint scanner to be used by clicking on the name of the  
                     scanner. 
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             iii. Click on Continue. The following screen is then displayed: 
 
 
 
 
 
 
 
* 
 
 
 
 
 
 
 
 
 
iv. Click on (select) and select the examiner’s name whose details are to 

           be captured. If the biometric data of the examiner had not captured, it displays a    

           message “Biometric data is not available” 

 
 
 
 
 
 
 
 
 
 
   
v. Examiner Biometrics: To capture the fingerprints of the examiner: 

 

(a) Click on Examiner Biometrics 

(b) Click on Enrollment under the Operations section 

(c) Select the first finger to be captured on the left hand  

(d) Ensure the examiner’s finger is well placed on the fingerprint device 

(e) Click on validate to check if the biodata already exists. If not click on enroll to 

capture the finger 
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(f) Select the next finger to be captured and repeat steps d and e for the left 

hand and the right hand. 

(g) Repeat the above steps for all the examiners to be captured. 

 

-If the biometric data of the examiner had been captured previously, select  

                       verification instead of enrollment. 

- Validation must be done first on each finger before capturing to ensure 

                      had not been captured before. 

 

        If the finger had been captured before, it gives an error message e.g as shown in  

        the screen below: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

vii. Photo Capture: To capture the examiner’s picture: 

 

(a) Click on Photo Capture 

(b) Select the camera to be used. 

(c) Ensure the examiner is well positioned in front of the camera . 

(d) Click on Capture. 

(e) Click on Save Picture. 
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vii. Signature: To capture the examiner’s signature: 

 

(a) Click on Signature 

(b) Ensure the examiner signs clearly on the attached device 

(c) If the signature is clear enough, click on Save Signature 

 

2. Documents:  

     this is used for the Upload of Examiner Documents. 

i. Click on the Biometrics and Documents link as seen in Fig 3b. The  

           following screen is displayed: 

 
 
 
 
 
 
 
 
 
 
 
 
 

ii. Click on Examiner Credentials and Click on Continue. The screen below  

       displayed: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
iii. Select the name of the examiner whose credentials are to be uploaded. 
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iv. Select the file type to be uploaded e.g. B.Sc. etc. 

v. Browse to the location where the file is stored. 

vi. Click on Confirm Upload. 

vii. Click on Submit. 

viii. Select another file type to be uploaded and follow steps v to vii until all the files 

       have been uploaded for the examiner. 

ix. Click on Close. 

 
 

Update or Amendment of Examiner Details: 
 

This option is not explicitly defined on the screen in figure 3b but can also be 

performed using the same interface. This option is used for updating examiner details 

and for adding gate crasher details to replace examiners who could not honor 

invitation for the current marking exercise. To continue: 
 
          i. Ensure that none of Swap Examiners or Move Examiner checkboxes is checked. 
 
          ii. Double click an Examiner record on the grid. This opens the screen below: 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
                                                            Figure 3C 

                     
iii. To update the current examiner, click Edit button; or New button to 

add gate crasher details in place of the selected examiner. 
 

iv. Supply the necessary fields 
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v. Check the I agree that all entries are correct as supplied by the 

Examiner 
  

vi. Click the Submit button 
 

vii. You can close the screen at any time or click Cancel when either 

Edit button or New button has already been clicked. 

 
 

A search provision has been made as shown in figure 3C to enable users 

search through existing examiners at a global level. This helps to check if the 

intending examiner already exists or in some cases where an examiner claims that 

he/she has been marking, it is used to resolve the authenticity of such claim. The 

repository contains all examiners in the whole federation. To use this option, Enter 

any of the names or telephone numbers of the Examiner and click the Search button. 

To use the currently selected paper code, check the box Use Paper Code. 
  
 
 
 
 viii. If the selected examiner packet 

has been re-allocated, Check the 
box and click the Submit button. 

 
4. USER/STAFF PROFILE SETUP 

 

The User/Staff Profile setup has already been described as part of the Setup 

Parameters. Additional user to the system can also be added when the user is 

logged in. 

 

To add other user/staff to the system: 

 

i. Click the File menu 
 

ii. Click Register User/Staff option. This opens the window below: 
iii. Enter the required items. All entries are compulsory. 

 
iv. Click the Submit button 

 
 
 
 
 
 
 
 



 
 
 

29 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
5. FINANCE MODULE 
 
5.1 Setting  
 
5.1.1  Banks 
       
This gives a list of available banks, their bank codes and head office addresses. This list 

can be added to by clicking on the New button and entering in the details required. 

Once details have been entered, click on Save/Update. 
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5.1.2 Bank Branches 

 

This gives a list of all the banks in Nigeria and their branches all over the country. This can 

be added to by clicking New and then clicking on Save/Update to save the new 

information.  

 

Information on the banks already present can be edited and updated by clicking on the 

Save/Update button. 
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5.1.3 Paper Fees 
This gives the Marking Fees for all the subjects. The fees can be edited and saved by clicking 
on the Save/Update button. 

 
 
 
 
 
 
5.1.4 Rank Fees 
 
        This displays the Coordination, attendance and vetting fees and Coordination fees for     

         English Language for Sole Examiners, Chief Examiners, Team Leaders In Charge,  

         Assistant Examiner, Team Leaders and Team Leaders. 
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5.1.5 Marking Status 
 

          
This displays the marking status to be used for each examiner to determine what stage of  
marking they currently are on. 
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5.1.5 VAT Settings 
 
        This window is used to enter in Examiners Payment Settings i.e Payment Date   
         and VAT Rate Setting 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
5.2 Preload Payment Templates 
 
      This is used to remove all existing data in the Finance Template and load default         
       entries for all examiners. Click on Preload Payment Templates under the    
       Finance menu. The window below opens: 
 
 
 
 
 
 
 
 
 
 
 
 
 
         Click Yes to continue. 
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5.3 Examiner Payments 
 
      This is used to enter in examiner details like marking status, bank details etc. to  
       determine if an examiner should be paid or not.   
 
       The examiners are grouped by the subjects they are marking. To view details,     
       Click on Examiner Payments under Finance and double click on a subject. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The examiners marking the subject are displayed in a window as shown below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Double click on an examiner to enter in payment details 
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Click on the edit button to update/modify payment details, marking status, no of scripts 

marked etc. 

Once all details have been updated, check the box “I agree that all entries are correct 

as supplied by the Examiner”, click on ‘Save’ and then click on ‘Close’. 

 

5.4 Compute Examiners’ Payments 

      This module is used to compute examiners’ payments.  

       Click on Compute  Examiners Payment Data under the Finance menu. 

      The window below pops up 
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Click on Yes to Continue. When completed, the total number of examiners data 
computed is displayed in a window as shown below: 
 
 
 
 
 
 
 
 
 

Only Examiners whose number of scripts marked have been confirmed will be computed. 

 
 
5.5 PED Operations 
 
This section is used by the Malpractice Officer to capture related malpractice detail 
at the Marking venue. See the menu representation below: 
 
 
 
 
 
 
 
 
 
 
 
 
 
Six items are specified on the Malpractice Officer menu: 

 

i. Malpractice Data Entry 
 

ii. Generate Broadsheet 
 

iii. Open Broadsheet Report 
 

      iv.       Centres for Scrutiny 
 
      v.       Update Malpactice Source 
   
     vi.       Upload Malpractice Data 
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5.5.2 Malpractice Data Entry 

 
       Malpractice Data Entry: This option is the data collection stage of the 

       malpractice stage. 

         i. Click Malpractice Data Entry. This opens the screen below: 
 

 

 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Note that Malpractice data is collected on Centre, Paper, Malpractice Description 

basis. 

ii. Select the Centre Number and Paper  
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iii. Select the Malpractice Type (Code and Description) 

 
iii. If the candidates are in a serial order, click on From To checkbox and select Cand 
Lower and Cand Upper and Click on Add to Grid button. 
 

 Note that for copy cases and other related cases, you would be required to enter 
the Questions numbers the cases were reported.  

To delete any record in the grid, select the record and press Delete key 
  
 

If the candidate numbers are not serialized, click on Click to Add Many blue link. This 

opens the screen below: 
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Click on the Candidate Indexes, select the affected candidates and click the left arrow 

button.  

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

To remove a candidate in the Affected Candidates list, double click the candidate index 
or click on the Index and click the right arrow button 
 

vii. Click on Accept Selection button to add to the Grid in the previous 

screen. 
 

viii. If any of the copy cases is selected and the officer had not provided the 

related question numbers, the system will prompt the user to supply the 

question number(s) as shown below: 

 
 

 

 

 

 

 

 
     

   Enter the required prompt and click the OK button or Cancel button to decline. 
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ix. Click on the “I agree that all entries in the grid are correct” 

checkbox at the bottom of the page. 

x. Click on the Save Grid Items button. 
 

You can view list of saved malpractice records for each 

centre number and paper in the right side grid of the window. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

xi. Repeat the steps for each Centre number, Paper and Malpractice 

code collected. 

You can delete any record made in error by clicking on the record and Clicking 

on the Delete button. 
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5.5.3. Generate Broadsheet:  

          This selection will generate the broadsheet for all collected malpractice 

and order the details on Rule, Centre basis etc.     
 

i. Click the Generate Broadsheet item on the menu. This opens the 

dialog below: 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Ensure you have registered your Malpractice Officer details. If this has not been done,  
 
you will not be able to generate the broadsheet for malpractice collected. 
 
To register the Malpractice Officer details: 
 

- Click on File 
 

- Click on Register User/Staff 
 

- Select the Malpractice Officer option in front of the Role combo box 
 

-Fill in all the details of the Malpractice Officer 
 
- Assign a username and password for login  

 
 

ii. To continue, click on the Yes button. The generation process 

completes and displays the information below: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
     
 
          iii. Click OK to continue 
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5.5.4.3   Open Broadsheet Report:  

             This option when selected will display the broadsheet for all the            

             malpractice data collected in the marking venue. See the copy below: 

 

The broadsheets are categorized based on the rules. All Centres whose malpractice 

description fall under the same rule are grouped together. E.g. In the figure above, the 

first page (Page1) displays all centres that fall under Rule Code: 2(1).  

 

 

 

 

 

 

 

 

 

 

 

 

 

Print 
Broad 
Sheet 
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The next page (Page 2) displays all centres that fall under Rule Code: 3(2). In the left 

pane of the above screen, the no of rules captured are displayed.  

You can print the broadsheet when you click on the icon at the upper left side of the 

screen.  

(*See section 7.1.2 To Print the Report) 

 

5.5.4.4   Updating Malpractice Source 

To update the Malpractice Source, Click on  

 

 

 

 

 

 

 

 

Exiting the application:  

To exit the application: 
 

i. Click the File menu OR Click the upper left hand close button 
 

ii. Click the Exit item in the menu. This opens the message below:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

iii. Click on the Yes button to end the application. 
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5.5.5 READING BROADSHEET DATA  

         To read broadsheet data, 

          -  Click on PED Operations on the menu bar 

          -  Click on Read Broadsheet Data 

         the window below opens: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

- Select a centre by clicking on the drop down arrow under Centre Info  

-Select a paper by clicking on the drop down arrow under Paper 

- Select Malpractice Type 

- Select Rule Code 

The details are displayed in the window below 

-Select preferred gender 

-Click on Read 

 



 
 
 

45 
 

 

 

5.6 SEAPDC Manager 

 
      This is used to capture offences committed by Examiners and Staff during the     
      Coordination and Marking Exercise. 
 
5.6.1 Offence Settings 
 
        i. Select Offence Category 
        ii. Enter the Offence description  
        iii. Select the penalty for the Offence 
        iv. Check the box “I agree that all entries are correct” and Click on Submit 
 
        The nature of offence and offence penalty is displayed at the left hand side of the   
         window. 
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5.6.2 Offence Capture 
 
         i. Select Offence Category 
         ii. Select Paper 
         iii. Double Click on Nature of Offence 
         iv. Select Examiner Code  
         v. Select Name of Reporting Officer 

               vi. Check the box “I agree that all entries are correct” and Click on Save 
 
 
 
TOOLS MENU OPERATIONS 
 

This menu provides listings for export of final list, database initialization and restore of 

previously backed up data. 

 

  
6.1 BackUp and Export Of Final List Data 

 

This operation when completed will create a physical secured file in the system 
 

for further transfer to Examiner Records Section, Yaba Office.  

This operation can only be used when the final list is ready and certified by 

the Head of venue. 
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To perform this operation: 
 

i. Click the Tools menu 
 

ii. Click Export Final List Data option. This opens the screen below: 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
                             Figure 6a 
 

 

 
iii. Check the specified box Check the Box to … 

 
iv. Click Start Backup button. The screen below opens: 
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v. Select subjects to be uploaded and check Confirm Backup. 

vi. Click on Start Backup                   

vii. the application backs up all required final list and related data to a 

physical file within the Data folder. 
 

viii. If the file already exists, you could see the message below:  
  
 
 
 
 
 
 
 
 
 
 
 
 
 

ix. If you click No button, the backup process will be canceled, but if you 

click Yes button, the backup process will complete with the message 

below: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

         x. Once the OK button is clicked, the process will open the location  

             where the file was saved on as shown below: 
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xi. Close the window and return to the application page. You can copy the file to the    

     CD to be sent to Yaba Office or use an internet service (if available) to upload   

           directly to  the internet. 

 

6.12 Data Restore From BackUp 

This operation will locate the previously backed up file and restore the data present 

on it for the Marking Venue 

i. Click the Tools menu 

ii. Click Restore from current  Exam backup item 

iii. Check the box to verify 

      iv. Click the Start Restore button.   

     The process must complete before you close the screen 
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6.2 Export Malpractice Data 
 
          This is used to export all data captured for reporting of malpractice.  

 

  (i) Under the Tools menu, Click on Export Malpractice Data 

 
 
 
 
 
 
 
 
 
 
 

(ii) Click Ok 

(iii) The malpractice data is exported and saved in a location on the system. 

 
 
 
 
 
 
 
 
 
 
 
 

iii. Once the OK button is clicked, the process will open the location where the file   
     was saved. 
 
6.3 Reset Marking Venue Database 
 

This operation when completed deletes all previous record for the Marking venue       

whether they have been updated or not and prepares the user to reset the 

Marking Venue and its data. 
 

This operation can only be used when the user has made a mistake of 

setting up a different marking venue data aside the required marking venue. 

To perform this operation: 
 

i. Click the Tools menu 
 

ii. Click the Reset Marking Venue option. This opens the screen below: 
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iii. Check the box Check the Box to verify …. 

iv. Click the Initialize Database button. This displays the message below: 
 
 
 
 
 
 
 
 

 

 

 

 

 

 

 

v. Click the Yes button to continue or the No button to decline. If the Yes 

button is clicked, all pre-loaded data will be removed. For setup steps, 

refer to the Setup section of this document. 

vi.  
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6.4  Import Centres 
         
          (i) To import Centres, Click on Tools – Import Centres. The following screen is    

              displayed: 

 
        
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
(ii) Check the box ‘Check the Box to Verify your operation’ and Click ‘Import Centre   

     Data”. Find where the centrefile is located and doubleclick it. A window opens as   

     shown below: 

 
 
 
 
 
 
 
 
 
 
(iii) Click Yes to import Centres. 
 
 
6.5 Upload To Online Server 

 

This is the final stage in the user operations at the marking venue. This 

operation transfers a backup copy of the marking venue data with the 

malpractice data (if any) to the National Office Server. 
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You must ensure that you have an internet connection on the user 

computer 

To start the restore process 
             

i. Click the Tools menu 
 

ii. Click Upload to Online Server item. This opens the screen: 
 

 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 

iii. Select the data to be uploaded (either the Quality Control Sample Data or the Entire   

      Final List Data of the Marking Venue). 

 

 
ix. Final List Data 
 

- Click the Check Box to verify the operation 
 

- Click on Continue 
    

- A window opens as shown below: 
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    -     Click on the OK button to open the screen below for confirmation of the  

           upload process and final upload of the marking venue data. 

 
 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

- Select the papers to be uploaded by clicking on the specific papers or click on 

Select All, If all the papers displayed are to be uploaded to the Server.                  

             

- Check the box to confirm data upload and then click on Upload to Server. 

You must ensure that you have completed all amendments and the 

Head of Venue has certified the details before you perform the above step. 

 

iv. Quality Control Sample Data 
   

- Click the Check Box to verify the operation 
 

- Click on Continue 
    

- A window opens as shown below: 
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Click Yes to continue. The window below opens: 

 

 

      

 

 

 

 

Click on the OK button to open the screen below for confirmation of the  

upload process and final upload of the Quality Control Sample Data. 

 

7.0 REPORT MENU OPERATIONS 
This menu listing is used to give the user access to preview and print 

available reports in the system. 
 

7.1 Provisional Examiner Reports: This report provides the report of the original data 

sent to marking venues from Examiners Records Section of the Yaba office as 

shortlisted. 
 
7.1.1 To display this report: 
 

        Click Report menu and point at Provisional List. This opens the sub menu         

        listing below: 
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ii. Click (Show All) option to display all the reports at a time, OR click a 

Subject option.  When (Show All) is clicked, this open the report 

screen below: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                                  
iii. When a single subject report option is clicked, it displays as shown 

below.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  
 
          The report preview is the same for both reports. 
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Notice the difference in the report display. The Show All report will display a 

grouping of all the subjects in the left side of the window. Notice the extract of the  

figure below. 

iv. To show the preview for a paper, click the paper code in the grouping (at the left  

     side of the window) 
 

iv. You can click the Close button at any time 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

THE LEFT SIDE IS THE 
GROUPING OF PAPERS 
FOR SHOW ALL 
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7.1.2 To Print the Report 
 

See the shortcut icons within the report preview show in figure below: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                                                        
 

      

 

 

 

Click the Print icon  as described above. This opens the dialog box below: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

ii. Select the printer you wish to print to and select/define other 

parameter (example Number of copies, Pages, etc) 
 

iii. Click the Print button or click Cancel button to decline the action 
 
 

Click to 
Export Click to 

Print 

Click to 
Refresh 
Report 

Click to 
Toggle 
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Other Report previews are Final List, Examiners Listing and Audit Trail (See 

the figures below) 

 

 

1. FINAL LIST  

 
  
 
 
 
2. LIST OF EXAMINERS 
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3. MARKING VENUE STAFF LIST 
 

 
 
 
4. QUALITY CONTROL SAMPLE 
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THE INTERNET PLATFORM 
 

This marking venue section of the internet option is used when there is no 

internet service on the user computer at the marking venue. In this case, the 

user need to back up the entire examiner data to an external storage device, 

example flash drive and take to any nearby internet café. 
 

To use the internet service to upload marking venue data 
 

i. Logon to http://examiners.waecnigeria.org 
the page below will be displayed:  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

ii. Click on Marking Venue Staff link  
 
 
 
 
 
 
 
 
 

 

This option allows the staff to login with the required user details and 
continue to upload the marking venue data. 

 

iii. Enter the login details (Email Address and Password) and click on 
the Login button. 
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iv. To register as a new user, click on the Register Here link. This will  

open the page below:  
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v. Enter the Registration Code sent to your head of venue and click the 
Login button. This will open the page below:  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

vi. Fill the user/staff details and click the Register User button. You will 
also receive an email to confirm your registration.  

Please ensure that you provide valid email address during the 

user registration process. This email can also be used to register a user 

on the offline platform. 
 

If you upload from the offline application, you can also logon to the 
online internet web application with the same credentials.  

vii. Successful user login will display the window below: 
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viii. Click Upload MV Data link to open the page below:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

ix. Browse to select the file you have backed up from the offline 
application. Confirm the Marking venue on which the data is being  
expected.  

If you do not select the marking venue contained in the file, you 

will not be able to upload the file. You cannot upload for any other 

marking venue other than the marking venue on which you were 

validated during the user registration. 
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x. When all required fields are selected, check the Continue 

Processing the selected file checkbox and click on the Validate and 

Upload Data button 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

xi. If a wrong file is selected, you will see the message as shown. 
 
 
 
 

xii. You can use the rest of the links on the user home page to see the rest 
of the actions available.  

xiii. Click at the upper right page to log out at any point or click on the Log  
Out link on the current page  

 or   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 


